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What this exercise is about

The objective of this lab is to show you how to use WebSphere Business Monitor dashboards in business
space.

Lab requirements
List of system and software required for the student to complete the lab.

* WebSphere Business Monitor V6.2 Toolkit installed with business space and Alphablox.

What you should be able to do

At the end of this lab you should be able to:
* Import the ClipsAndTacks model into a new workspace
» Create a new dashboard and add widgets to the dashboard
» Configure dashboard widgets

» Configure Alphablox based widgets
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Introduction

Similar to the dashboard of an automobile that provides easy access to your odometer and check-engine light,
WebSphere® Business Monitor offers a browser-based dashboard that can provide easy access to important
information about the current state of your business.

Business Space is the featured browser-based dashboard that is provided with WebSphere Business Monitor
and other WebSphere products. WebSphere Business Monitor also provides portlet-based dashboards for
WebSphere Portal users. Business Space and portlet-based dashboards provide the same functionality.

This lab shows you how to use business space dashboards.

Widgets: Alert manager, alerts, instances, KPI manager, KPIs, KPI history and prediction, diagrams, human
tasks, export values

Alphablox based widgets: Dimensions and Report

For more information about the human tasks and export values, refer to lab for Clips And Tacks BPM,
WBMonitorV62_ClipsAndTacksLab_BPM.pdf.

For more information about the KPI history and prediction widget, refer to lab for KPI history and prediction,
WBMonitorV62_KPIHistoryPredictionLab.pdf.

Prerequisite: For displaying the diagrams widget, ensure that one of the following is installed:

 Adobe SVG Viewer - http://www.adobe.com/svqg

* Renesis SVG Viewer - http://www.examotion.com
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Part 1: Import the Clips And Tacks visual monitor model
In this section, you will import the Clips and Tacks visual monitor model into the workspace.

1. Start Rational Application Developer or WebSphere Integration Developer and setup the
environment

a. Start Rational Application Developer or WebSphere Integration Developer, and when prompted
point to a new workspace such as c:\workspaces\ClipsAndTacks

b. Click OK
c. Close the Welcome tab

d. You want to open the Business Monitoring perspective. From the main menu select Window >
Open Perspective 2 Business Monitoring

___e. If prompted for Confirm Enablement, click OK

2. Create a new monitoring project

___a. Right click the Project Explorer, then select New - Business Monitoring Project... from the
pop-up menu

___b. Enter ClipsAndTacks in the 'Project name' field

__c. Click Finish. You will see the new project in the Project Explorer view

% o < 8]

3. Import the supplied cbe files with the ClipsAndTacks lab files
a. Right click in the Project Explorer view, and then select Import... from the pop-up menu
b. Select General - File system from the Import dialog and click Next

c. In the following panel, click the Browse button to locate the files, for example,
<LABFILES62>\ClipsAndTacks

d. Select ActivityEvent.cbe

___e. Do not select the .mm file in this folder

__f. Select DeclinedOrderEvent.cbe

___g. Select LateAverageOrderShippedEvent.cbe

__h. Select NewOrderEvent.cbe

___i. Click the Browse button and select ClipsAndTacks from the “Import Into Folder” dialog
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4= Import
File system

Import resources From the local File system, i"" /

From direckory; | SETEE I EE=pR e {x=ralyt ) f=Te j Browse... |

...... = ClipsandTacks

@ ActivitvEvent.che

E‘_ ClipsandTacks.mm

@ DeclinedOrderEvent.che

@ LatedverageOrdershippedEvent,che
@ MewrderEvent, che

EEEOR

Filter Twpes. .. | Select Al Deselect all |

Irko Folder: | ClipsandTacks

Opkions

- Cverwribe existing resources withouk warning
" Create complete Folder structure

% Create selected folders only

(7] < Back Mext = | Einish I Cancel

__j. Click Finish

4. Import the supplied mm and svg files
___a. Right click in the Project Explorer view, and then select Import... from the pop-up menu
__b. Select General - File system from the Import dialog and click Next

__c. Inthe following panel, click the Browse button to locate the files, for example,
<LABFILES62>\VisualModel

___d. Select ClipsAndTacksSVG.mm
___e. Select ClipsAndTacks_KC.svg

___f. Select ClipsAndTacks_MC.svg

___g. Click the Browse button and select ClipsAndTacks from the “Import Into Folder” dialog
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+4= Import
File system —
Import resources from the local file system, .-_’ .n_“
-l
From directory: I C:iLabfilesa1 i WisualModel j Browse, .. |
[ (= MisualMadsl Bl ClipsandTacksSvi. mm

&) ClipshndTacksyel_KC.svg
&) ClipsAndTacksys1_MC.svg

Filter Twpes. .. | Select Al Deselect all |

Into Folder: | ClipsandTacks

Opkions
| Cverwrite existing resources withouk warning
" Create complete Folder structure

% Create selecked folders only

(7) < Back. Mexk = | Finish I Cancel

___h. Click Finish

5. Expand the project in the Project Explorer view, then expand the Event Definitions and you will see
the new events listed. Expand Monitor Models and you will see the new ClipsAndTacks model
listed. Expand the SVG files and you will see the SVG files listed.

m =

[ 5, Project Explorer X W & o=0O
= Ti‘} ClipsandTacks

El]_.F' Ewent Definitions

e @ ActionServicesEvent, che

- @ AckivityEvent,che

= @ DeclinedOrderEvent.che

-8 v Files
-9 ClipsandTacksve1_KC.svg
LB ClipsandTacksWel MC.svg
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Part 2: Publish the model to the server

In this section you will use Rational Application Developer or WebSphere Integration Developer to publish
the monitor model to the monitor server.

1. In Project Explorer, expand ClipsAndTacks = Monitor models - ClipsAndTacks.mm. Right click
over ClipsAndTacks.mm and then select Generate Monitor J2EE Projects from the context menu

2. If you have already generated the ClipsAndTacks model for another lab, then you may need to
select 'overwrite existing projects'. Then click Finish.

3. A progress dialog shows the status of the operation and it closes when the operation is complete.
Check for errors in the Problems view. There may be warnings, but there should not be any errors. If
you see errors, then try to perform a clean to see if the errors can be removed: Project > Clean... >
select 'Clean all projects', then click OK.

4. Click the Servers tab, then right click and select the Start option to start the server WebSphere
Business Monitor v6.2. This may take a few minutes to complete.

I/Mnnitoring Flawy | Properties | Problems m\wogress |

Server Skatus Skate

[#8 wwebsphere Business Monitor ve.1 i Started Republish
"% WebSphere Process Server w61 Fig Stopped Republish

5. Right click in the servers view and then select Add and Remove Projects...

6. Click Add to move the ClipsAndTacksApplication from the list of available projects to the list of
configured projects. Click Finish. Note: If the application is already in the list of configured projects,
then you may have run another lab and published this application already, so in that case, cancel
this window and select the 'Publish’ option from the server menu.

7. A progress message is displayed in the lower right corner of the window.

8. Check the messages in the console view. You should see the following message when the
application has been started:

Application started: ClipsAndTacksApplication

9. Inthe servers view, right click, then select Run administrative console. You should see it open in
a separate tab. It will prompt you for user ID and password. Enter admin for user ID and then enter
admin for password.

10. Click Log in

11. Click Applications > Monitor Models. The application should show green status if it started
successfully.
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Welcome wid Help Logout | z::;l
-

Monitor Models =

Monitor Models

Use thiz page to rnanage all versions of monitor rmodels and their associated applications, To
start or stop a version of a monitor model, you must start or stop the associated application.

FPreferences

Startl Stopl Install Update
k| [
B @ (P
Select Model 2 Werslem Deployment > | Application 2 Status (9
O ClipsAndTacks Z007-03- Ok ClipzAandTacksapplication | S
117120730
Total 1

12. If the model shows red (stopped), then wait a moment, then refresh by clicking on the icon to the

right of Status in the last column of the table. You should see green (started) for the model. If it does

not show green, be patient and keep refreshing until it does show green.

13. Check the server log to ensure there are no problems. You can check this in the console view.

14. If you are using the integrated server within WebSphere Integration Developer or Rational
Application Developer, then you do not need to setup Monitor data security, since the administrative

user is automatically authorized to all models. If you are using a different server, then you should
open the administrative console, navigate to Security > Monitor Data Security, then add the
model, role and user information to a resource group.
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Part 3: Run events to exercise the model

Rather than installing a J2EE application to actually create the events that you want to monitor, you are going
to use a program to simulate the submission of events from the application.

The supplied program is '‘BatchCBEWTriter61' and it will submit the events to the Common Event Infrastructure.
Look for the program in \Labfiles62\ClipsAndTacks\BatchCBEWriter. This program reads XML files which
represent the common base events for the model.

1. Update BatchCBEWrfriter61.bat to point WAS_HOME to the monitor server home, for example 'set
WAS_ HOME=C:\IBM\WebSphere\AppServer'. If you are using the integrated monitor server in
WebSphere Integration Developer, the path would be <WID-Install-Path>\pAWBMonSrv_wps. If you
are using the integrated monitor server in Rational Application Developer, the path would be <RAD-
Install-Path>\pfAWBMonSrv.

2. Update config.properties, setting the serverName and portNumber. You can find the port number by
browsing the server log and finding 'bootstrap port'. For example, check for the log at
C:AIBM\WebSphere\AppServer\profiles\WBMon01\logs\server1\SystemOut.log . For the integrated
server in WebSphere Integration Developer, the path would be <WID-Install-
Path>\pAWBMonSrv_wps\logs\serverl\SystemOut.log and the portNumber should be 2810. For the
integrated server in Rational Application Developer, the path would be <RAD-Install-
Path>\pAWBMonSrvw\logs\server1\SystemOut.log and the portNumber should be 2810. Here is an
example of the config.properties settings:

| ocal host

__a.connect. server Nane
___b.connect. port Nunber = 2810

3.  Open a command window, then change directory to the folder containing BatchCBEWTriter61, for
example, type this command

___a. cd\Labfiles62\ClipsAndTacks\BatchCBEWTriter
4. Run commands to load the common base events to the server.
__a. batchcbewriter61 -Dsource.filename="c:/labfiles62/clipsandtacks/cbe/allevents.xml"

___b. When it prompts you for user identity and password, enter ‘admin’ for both (without the quotation
marks)

5. When you run BatchCBEWriter61, you should see results such as:

C:swdriverssevents*batchchewritertl —Dzource.filename=""c:- drivers-events-clipsand
tacks-allevents . xml"

Hemoving Globallnstancelds.
Setting missing values.

pdating timestamps.
alidating CBE=.
ending CBE=s.
TART=0%:14:18._875

cheliBl.
chelZ2B].
chel3B].
chel481]1.
chel581.
chel6B]1.
chel?81.
g chelBB1.
:14:24.398
otalTime=135%1% milliseconds.
BEz/second=6.215316315205327
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Part 4: Create a dashboard in business space

In this section you will build a dashboard in business space.

1. Create the dashboard.

__a. The default browser is 'Internal Web Browser', but you should not use this one since some
standard functions are not provided that you may need. Select Window > Preferences > General
> Web browser > select 'Use external Web browser'. Select an external browser. Click OK.

__b. InWebSphere Integration Developer, in the servers view, right click and select Business Space

___¢. When prompted, enter admin for the user ID and enter admin for the password. You must log in
with 'admin’ so that you can view the alerts which were setup in action manager to be sent to this
particular user ID. Also, in the toolkit environment, this is the user that is automatically defined on
the secured server.

___d. Click the icon to create a new space.

&® Your Business Space

s

% L0 Groupby | Busiress Space - || Search

Better Lender Space | Owned by admin admin | Pages: 6
o The Getting Started module of IB WebSphere Business Monitor W62 uses Better Lendarzpace
widgets. By following the instructions described in Get..

» J@ Welcome | Dwned by System Administrater | Pages: 1
|_' Faorlearning about Business Space

___e. Enter a name such as Dashboard, select Empty, then click OK.

___f. Click the icon to create a new page in the Dashboard space.

&= Your Business Space

i %| Ol Bl | Groupby | Business Space - ||| S=arch

Better Lender Space | Owned by admin admin | Pages: 6
o The Getting Started module of IB WebSphere Business Monitor W62 uses Better Lendarzpace
widgets. By following the instructions described in Get..

¥

- =p Dashhoard | Owned by admin admin | Pages: 0

» J@ Welcome | Dwned by System Administrater | Pages: 1
Faorlearning about Business Space

___g. Enter a name such as Pagel, select Empty, then click OK.

__h. Click Pagel to open it.

s I;' Dashboard | Dwned by admin admin | Pages: 1

1 P%ﬁe1 | Cwwned by admin admin
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___i. Now you can add widgets to the page by clicking on 'Add widgets' in the upper right corner

1y Add Wildgets -
o _— , then dragging a widget to the page. If you want to rename the page, change the

layout or remove the page from display, use the icons to the right of the page name on the tab

Pagel + x . . . . .
aae . To return to the business space list, click '"Manage Business Spaces' in the upper

right corner
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Part 5: Instances widget
1. Add the instances widget to the dashboard, and configure it to cooperate with other widgets.
___a. Click Add widgets, then select Instances and drag it to the page.

___b. Click Configure on the widget menu.

=0

1) To Access the menu, hover the mouse over the right corner of the widget {b and
then click the down arrow. On this menu you can configure the widget, refresh the widget
and delete the widget.

=, -Refreshib

3¢ Delete
() Help

=0

___C. Click the Show/Hide tab, and select monitoring context 'ClipsAndTacks MC'.
EFclipsandTacksiacrass all versions)
(- lipsAndTa C
Click button >> to move all the fields to the Selected box. Also,
click button 'Set as default’ which will make this the default monitoring context to display.

___d. Click the Cooperative tab, then select 'Enable this widget to interact with other widgets.'. This
will allow you to link this widget to other widgets such as diagrams or KPIs.

___e. Then click OK. You should see a list of monitoring context instances for the events that you just
processed.

Instances

city ClipsAndTacks HKey COMPLETED country CreationTime Monitoring Context Timer Order End Time Order Fulfillment Duration Order Start Time Order Status Sh
*

Faleigh o1 USA January 5, 2008 Oe Augustd, 2006 2d, 0h0m,0s August 7, 2006 Shipped 1
1:44:41 PW 320:08 AW 220:08 AW

Toronto 02 * Canada January g, 2008 0Og August 11, 2006 4d 0h0m0s August 7, 2006 Shipped 1
1:44:41 PM 4:14:96 AW 4:14:56 AW

Mexico 03 Mexico January 5, 2009 17 m, 24 5 0s August 7, 2006 = 0

City 1:44:41 PM 5:01:22 AM

Raleigh o4 USA January 5, 2008 17 m, 24 5 0s August10, 2006 R 1]
1:44:41 PM B:01:34 AW

Toronto ob Canada January 5, 2008 17 m, 24 s 0s August12, 2006 M= 1]
1:44:41 PW TA2:22 AW

Faleigh of * US4 January 5, 2008 Oe August 36, 2006 4d0h0m0s August 22, 2006 Cancelled 1]
1:44:41 PW 320:05 AW A20:08 AW

Toronto o7 * Canada January 5, 2000 05 August 27, 2006 Gd 0h0m,0s August 22, 2008 Cancelled 1}
1:44:41 Pm 4:14:55 AW 4:14:55 AW

Mexico 08 Mexico January 5, 2009 17 m, 24 5 0s August 22, 2006 = 0

City 1:44:41 PM a:01:22 AW

Raleigh o9 USA January 5, 2008 17 m, 24 5 0s August 22, 2006 N 1]
1:44:41 PW Bi01:34 AW

Toronto 010 Canada January 5, 2008 17 m, 24 s Os August 22, 2006 I ey 1]
1:44:41 PW T12:22 AW

1 |

1-10 20 kB
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Part 6: Diagrams widget and cooperation with instances widget
1. Add the diagrams widget to the dashboard, and configure it to cooperate with other widgets.
___a. Click Add widgets, then select Diagrams and drag it to the page.

___b. Click Configure on the widget menu.

=0

1) To Access the menu, hover the mouse over the right corner of the widget {b and
then click the down arrow. On this menu you can configure the widget, refresh the widget
and delete the widget.

J— v | o
Q;Conﬂgur@

%, Refresh
3¢ Delete
() Help
___c. Select the model and monitoring context.
» Select the ClipsAndTacks model
» Select “Monitoring context”
e Select “ClipsAndTacks MC"
___b. Click the Cooperative tab, then select 'Enable this widget to interact with other widgets.".

__c¢. Then click OK. You should see the diagram displayed in the view.

Diagrams
ClipsAndTacks MC

Chedc

Customer

Ancount a
Status
a Ship Order
e to Customer

S0.0% Yes

50.0% “es

Cheek Order Approve

Handling Policy Without

for Autom atic Revien?
Approval

faccount in
Good
Standing?,

S0.0% Yes

Acceptable
Cradit Risk?

[C] Order
50.0% Mo @_I a
S0.0% Mo
)
50.0% No
_ 5 B
I/\I Review Order

2. Click the diagram icon in the instances widget to see the diagram for specific instances.

Cancel Orde

and Send
Hotification
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___a. Inthe dashboard, scroll up to the instances widget and find one of the monitoring contexts that
show 'Cancelled' in the order status column.

on Raleigh 06 B usa 0s o e | Eh 0 in € 2086 2:20:05 Cancelled  © 350
AM e = AM
d><p Toronto o7 * Canada 0= g;g:sg :21?4J:55 B d'DD bl 2;3:53:2124,:55 Cancelled a 400
AM me = AM
___b. For this item, click the icon in the first column in the diagram column. This will cause the
monitoring context diagram view to be updated for this specific monitoring context. The visual
model in the monitor model is designed to color code the shapes in the diagram based on the
status of the order. Since this particular order is cancelled, the diagram should show the task
'‘Cancel Order and Send Notification' as blue in color.
___c. Click 'Restore Original Context' at bottom of this diagram to return this diagram to the generic
diagram.
| Restare Qriginal Cantent |
___d. Inthe dashboard, scroll up to the instances view and then find one of the monitoring contexts
that show 'Shipped' in the order status column.
d><p Raleigh ol * (W= 0= ggg:s;:%o:os 2 @, O 2;3:?:;’0:05 Shippad 1 100
AM MBS AM
d><p Taranto oZ * Canada 0s ;;g;s;:jf‘-{:SS :nd' Dsh' g ’;;g;s;:?ltt:SS Shipped 1 150
AM ’ AN

___e. For this item, click the icon in the first column, the diagram column. This will cause the monitoring
context diagram view to be updated for this specific monitoring context. Since this particular
order is shipped, the diagram should show the task 'Ship Order to Customer" as blue in color.

_ﬁ ..2..] [C] Order
®
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Part 7: KPIs widget
1. Add the KPIs widget to the dashboard and configure it
___a. Click Add widgets, then select KPIs and drag it to the page.

___b. Click Configure on the widget menu.

=0

1) To Access the menu, hover the mouse over the right corner of the widget {b and
then click the down arrow. On this menu you can configure the widget, refresh the widget
and delete the widget.

3¢ Delete
() Help

___c. Onthe KPIs tab, click the ([#]) icon to expand the ClipsAndTacks model's available KPI metrics

v Awerage Crder Fulfillment KPP August 2006
¥ Average Order Price KFI (Dollars)

W Declined Order KFI

W Grder Count KPI

W Percent of Ordars Approved kP

' ship Count KPI

___d. Select the check boxes next to the KPIs you want to monitor.
___e. Click the Cooperative tab, then select 'Enable this widget to interact with other widgets.".
__f. Click OK

__ 0. The KPIs are displayed in the default table view as shown below:

KPIs

KPI Hame Status Walue Target Actions Walue in Range

Average Order Fulfillment KPI August 2006 3d18h0m,0s 3d,0h,0m,0s ?‘:* L:.E A W _ﬁ_
fwerage Order Price KPI (Dallars) A75 3nn = B A ™ -—
E= | &% A8 |55 ==

___h. The status column shows icons for the range that is associated with the current value. In this
case, the icons have not been defined. You can define the icons for the ranges by opening the
KPI properties, and clicking the Range tab.

___i. This widget shows for each KPI the current value, target value and a bar chart that depicts the
current value, target value and ranges.
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j- On the widget menu you can select 'Send Widget..." to send a screen capture of the KPIs as an

attachment to a human task.

k. In the Actions column, you can click icons to perform various functions:

) “* Show instances in the instances widget for this KPI. For this to work, you need to click
the Cooperative tab on both the instances widget and the KPIs widget, and select 'Enable

this widget to interact with other widgets.".

2) Show KPI properties for this KPI.

1
3) “* Show alerts for this KPI. This will open the Alert Manager and show only alerts for this
KPI.

4) 1 Open the KPI history and prediction configuration for this KPI.
I. To view the KPIs in a different layout, click one of the icons in the lower left corner of the widget
For example, here is the widget after selecting the half gauge format:

KPIs
- Order Count KPI

Average Order Fulfiliment KPIl August  ~
2006 Average Order Price KPI (Dollars) Declined Order KPI
10 14

&
g 5 20
1000 10 0 25

gﬁﬂ@ﬁ |
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Part 8: Alerts widget
1. Add the Alerts widget to the dashboard and configure it.

___a. Click Add widgets, then select Alerts and drag it to the page.

___b. Click Configure on the widget menu.

=B
1) To Access the menu, hover the mouse over the right corner of the widget {b and

then click the down arrow. On this menu you can configure the widget, refresh the widget
and delete the widget.

=, Refresh{b

3¢ Delete
() Help

=0

___C. Click the Cooperative tab, then select 'Enable this widget to interact with other widgets.".

___d. The alerts view is added to your dashboard, and you should see alerts listed.

Alerts

| Mark Read || tark Unread || Forward Alert || Remove |

Subject ~ Date and Time Alert Source

+ Declined orders January 8, 2008 12:37:50 PM ”@

o Order processing time January 8, 2008 12:37:38 PM “’@

___e. There are buttons to mark and alert as read or unread. There are also buttons to forward the
alert or remove an alert.

___f. You can click an alert in the list, then you will get a pop-up showing the details of the alert.

Subject Date ar

. Order;?lrum/ﬁiaingtime Januar,
o Decli i

anuar,
January 5, 2009 2:49:20 PM
Subject
Order processing time
Business situation name
Average shipment is too late
Comments

The awverage order processing time i=s 3.750 davys.

Close

___g. The column Alert Source can be used to show the instance or diagram for the alert. Notice that
in this case, the alert source icons are disabled (grey), and that is because these alerts were
based on KPIs rather than on monitoring context instances. If you have alerts based on
instances and you setup the cooperative mode on the widgets, then you could click on the alert
source to see the corresponding instance data or diagram instance information.
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___h. Click Configure on the widget menu and you can customize the view including changing the
color of the read and unread alerts.
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Part 9: Reports widget

In this section you will add the reports widget to the dashboard and configure it. The reports widget uses
Alphablox for displaying multi-dimensional data in graph form, where the data is displayed relative to the time

axis.
1. Add the Reports view to the dashboard canvas and configure it to analyze the performance data
relative to time
___a. Click Add widgets, then select Reports and drag it to the page.
___b. Click Configure on the widget menu.
@: a
1) To Access the menu, hover the mouse over the right corner of the widget and
then click the down arrow. On this menu you can configure the widget, refresh the widget
and delete the widget.
E— A =
8=];Conflgurg
=, Refreshib
3¢ Delete
() Help
___¢. On the report options tab select the following values:
* Monitoring Model : ClipsAndTacks (All Versions)
e Monitoring Context : ClipsAndTacks MC
» Dimension : Location
* Analysis Type : Basic
» Time range . Click button 'Year to Date'
* Frequency : Monthly
* Measures : Select the check box next to InstancesCount
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Meazures

| ClipsAndTacks (All Wersions)

j =] Reports View Measures

2009 February, 13

™ Sum of new items

= Sum of resolved items
=] Modeled Measures
M |

Monitoring context:

[ ClipsandTacks MC x|

| g
O Average Order Price
™ Sum Drder Price

r Order Caount

Dirnenzion:

| Location

Analysis type:

IEIasiu: 'I

weighing factor:
E

Tirme range (filkers the data to report by the timme range vou specify]
Frorm:

Manday, January 01, 2007 12:00:00 AM

To:
Thursda',', Decernber 06, 2007 5:27:56 PM
rearto Date | Maonth to Date

Frequency:

|MDntth 'I

___d. Click the Cooperative tab, then select 'Enable this widget to interact with other widgets.".
___e. Click OK

___f. The Reports view displays the instances count based on location relative to creation time as
shown below.

File Edit “iew Bookmarks Data  Chart Tools  Help
B |¢-$-|@ & 2|9
7 E a4 E

o . n .
CreationTime 1 Location T InstancesCountt)
2000 1) All Location 1) 20

0 | January | All Location 1) 20

January
CreationTime
All Location InstancesCount

Double click All Location on the first row to drill down by location.
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Reports

Basic analysis

File  Edit “iew Bookmarks Data  Chart Tools  Help
D Y- @8 & ?
1% % E 4 F
1 : . . .
4 CreationTime 1 Location  t]  InstancesCount £}
All Location 1) 20
: [ ] p— :
4 2009 1)
G Mexico 1) 4
CreationTime :
Canada InstancesCount Ml Mexico InstancesCount US4 InstancesCount usatl 8

3. Use the main menu of the reports view to manipulate the visualization of the performance analysis
to your needs

4. To see the instances that aggregate to the counts in the table, just right click any cell in the table
and select menu item Show Intances, then this will show the instances in the instances widget. You
also need to setup Cooperative mode on both widgets to enable this capability.

Sort...

Corill Up -

Crill Diowen

Expand All

Piwot

Show Instances [

Show Only

Hide

Unhide &l

20 keep Only
_ Remove Only

Advanced »
Swap Axes

InstancesCount

Member Filter...

Options...

5.  You can also configure additional measures in this view. To do this, click the configure option and
select any of the Measures and save the configuration.

6. If you want to see how to place a different dimension other than CreationTime on the X axis of the
chart, then follow this procedure.

___a. Click Chart > Axis Placement...

___b. Change CreationTime to 'legend’, and change Location to 'x-axis'. This will put Location on the X
axis of the chart.
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Axes Placernent

Select where each dimmension should appear on the chart

O Altornatically assign chart axes

CreationTime I legend 'I
Location I H-aMis "I
Measures I legend vI

__c. Click OK.

___d. Now you will see Location on the X axis of the chart.

File Edit “iew Bookmarks Data Chat  Tools  Help

2

E | |¢-o- @8 a;s

Drill Down - |5 [%
10 . ) .
CreationTime 11 Location 1] InstancesCount )
All Location +) 20
] Canada 1} g
. {20091,
Canada Mezxico usa Mexico 1) 4
Locatioh

¥ January InstancesCount Usa 1] 2

2009 February, 13 IBM WebSphere Business Monitor 6.2 — Lab exercise Page 22 of 32

Business space dashboards



© Copyright IBM Corporation 2009. All rights reserved

Part 10: Dimensions widget

In this section you will add the dimensions widget to the dashboard and configure it. The dimensions widget
uses Alphablox for displaying multi-dimensional data in graph form, where the data can be displayed and
analyzed using dimensions which are defined in the model.

1. Add the Dimensions view to the dashboard canvas and configure it

___a. Click Add widgets, then select Dimensions and drag it to the page.

___b. Click Configure on the widget menu.

___C. To Access the menu, hover the mouse over the right corner of the widget

{5:5

and then

click the down arrow. On this menu you can configure the widget, refresh the widget and delete

=, -Refreshib

3¢ Delete
(?) Help

the widget.

__d. In the Select Dimensions tab, select the following values:

1.

2.

2009 February, 13

Monitoring Model: ClipsAndTacks (All Versions)
Monitoring Context : ClipsAndTacks MC

Select Location from the Available Dimensions list and click the right direction arrow
() next to Row Dimensions text area.

Now select Order Status Dimension from the Available Dimensions list and click the
right directional arrow () next to Column Dimensions text area

Now select Measures from the Available Dimensions list and click the right direction

arrow ) next to Page Dimensions
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Dimensions

*Maonitaring Madel: *Manitaring context:
ClipsAndTacks (4l Yersions) =| |ClipsAndTacks MC =]
Available dimensions Row dimensions
CreationTime ;l L= Location
TerminationTime
=
*Column dimensions
Order Status Dimensi
=
Page dimensions
= =

[ Hide mznu bar
[T Hide toalbar

___e. Click the Cooperative tab, then select 'Enable this widget to interact with other widgets.".

__f. Click OK.

___g. The Dimensions view displays the instances count based on location and order status.

Dimensions

File Edit ‘iew Bookmarks Data  Chart Tools  Help
h |-+ W & & |9
- 1% B 4 B B

Measures | InstancesCount j

€ @ Location  t) Al Order Status Dimension 1)
i 4

3 1 AllLocation 1} 20

: ’_

5 | i

o] :

w0 T :

= 3

- Al Order Status Dimension 3

Order Status Dimension
/ All Location
2. You can double click All Location to drill down on location.
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Measures | InstancesCount j
E 10 Location L All Order Status Dimension £
=]
2 All Location 1} 20
[ X}
= Canada 1) ]
]
£ .
Al Crder Status Dimension Mexico 1} 4
Order Status Dimension UsA 1) a
| Canada @ Mezxico / USA
3. You can double click Canada to drill down on a specific country.
Measures | InstancesCount j
£ . Location  t) All Order Status Dimension T}
2" 3
o { Al Location 1, 20
£ 10
£ — | i Canadat] ]
£ |
= Al Order Status Dimension 4 Toronta T} 8
Order Status Dimension Mexico 1, 4
! Toronto
en 4+ [u]
4. You can double click 'All Order Status Dimension' to drill down on order status.
Measures | InstancesCount  »|
£, All Order
H - Status T Canceliedt) MNewtl Shippedt)
E All Location T} pimension
% ’; Canada 1) 20 F 12 4
B0 T T T :
= Cancelled Mewy Shipped Toronto 4 8 2 4 2
Order Status Dimension Mexico 1, Q 2 4 5
J Toronto R

5.

To see the instances that aggregate to the counts in the table, just right click any cell in the table

and select menu item Show Intances, then this will show the instances in the instances widget. You
also need to setup Cooperative mode on both widgets to enable this capability.

— Showlnstances
Show Qnly E

All Order
Status
Dimension

g8

=

6.

Sort..

Drill Up
Drill Dowen
Expand All
Piwat

Hide
Unhide All

Keep Only
Remave Qnly

Advanced 3

Swap Axes
Mermber Filter...
Calculation Editor...

If you want to perform analysis on different dimensions in the model, select the Configure widget

menu option and move different dimensions to the row, column and page dimensions.

2009 February, 13

IBM WebSphere Business Monitor 6.2 — Lab exercise

Business space dashboards

Page 25 of 32



© Copyright IBM Corporation 2009. All rights reserved

Part 11: KPI manager

You can use the KPI manager to view existing KPIs and to create, copy and delete KPIs.

- éMAddWidgetS‘
£l e

@, then

1. Click Add widgets, then page forward using the right arrow
select KPI Manager and drag it to the page.

2. Select ClipsAndTacks from the drop down list for the Model field

3. You see a list of the existing KPIs that were defined using the Monitor Model Editor. You can click
the KPI Name to edit a KPI, or you can use the Actions button to create, edit, copy or delete KPlIs.
Note that for KPI's that were created in the monitor model editor, you can only update the target,
and the remainder of the settings including ranges are not modifiable. If you need to update these
settings, you could make a copy of the KPI, then update the copy.

KPI Manager
Modal: | ClipsandTacks w| version: [Latest v
KPI Name Created Owner Type Access
O Awerage Order Fulfillment kP August 2006 Wodeled = Aggregate Shared
() Awerage Order Price KPI (Dollars) hiodeled - Aggregate Shared
() Declined Order KPI Modeled - Aggregate Shared
O Order Count KPI Modeled o Aooregate Shared
O Percent of Orders Approved KPI Wodeled - Expression Shared
) Ship Count KPI hiodeled - Aggregate Shared

4. To create a new KPI, click the Actions button. You can create an aggregate KPI that performs a
function against a metric. You can also create a calculated KPI that uses calculations that reference
other KPIs. For this example, select New Aggregate KPI.

Hew Aggregate KPI Properties

Hame

* kPl name:

Description:

mModel azsociated with KPI:
| ClipsAndTacks v/

Access:
(® Personal

) Shared

5. Create a KPI that sums the total price of orders. Select the Name tab and enter the following
information:

___a. KPI Name : Total Price KPI
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___b. Select the Definition tab and enter this information:
e Operator: Sum
» Metric: Browse to ClipsAndTacks MC > totalPrice
New Aggregate KPI Properties

Definition

* Operatar; * hetric:

| Sum v| totalPrice

Time reference

|N|:une |v|

Diata filter (Limits data to instances which match the specified criteria)

Add

___c. Take alook at the other tabs to see that you can enter target values, ranges, data filters, and
many other preferences. You can also click the Preview tab to see how the KPI will look on the
dashboard.

__d. Click OK

__e. The new KPI has been added to the list of KPI's, and now it can be displayed in the KPI view of
your dashboard.

KPI Hame
Average Order Fulfillment KPL August 20068

Average Order Price KPI (Dollars)
Declined Qrder kP

Order Caunt KPI

Fercent of Orders Approved kPI
Ship Count KPI

Total Price KPI
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Part 12: Alert manager widget and subscriptions

Using the Alert Manager dashboard widget, you can subscribe or unsubscribe to predefined alert notifications
and have the natification sent to your dashboard, e-mail inbox, pager, or cell phone. From the Alert Manager,
you can also create new alerts that other users can subscribe to.

1. Add the alert manager to the dashboard

___a. In Business Space, use the Add Widgets menu to drag the Alert Manager widget to the
dashboard.

___b. In this widget you will see existing alerts listed, so you can edit, copy or delete them. You can
also change your subscription information or create new alerts.

Alert Manager

Alerts o Display | All alents [~] Mew Alert Save
Alert Name Description Owner ~ || pashboard alert _| cellPhone | E-mail _| Pager Actions
Fee Compliance Alert v =] = =] 'L|

2. Create a business user alert when the declined orders are in the high range.
___a. Click the New Alert button.

___b. Enter an alert name and optionally a description and select the Clips And Tacks model.

Conditions | Alert Content  Motification

Alert nama | Declined arders high

Descriptian |
Madel | ClipsAndTacks 2007-09-11 12:07:30
Owener |admin

___c. Inthe Conditions section, click Add, which will add a row to the conditions table.

Conditions
Motify when all of the following conditions apply Add
KPI Name Prediction Model Condition Value
Clickto choose KPI Mone (Use actual data) Click to choose condition Clickto choose value *®

___d. For KPI Name, click to choose Declined Order KPI.

___e. For Condition, click to choose 'In range'.

__f. For Value, click to choose range High.

Conditions
M otify when all of the following conditions apply Add
KPI Name Prediction Model Condition Value
Declined Order KPI Mone (Use actual data) In range High Range b4
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___g. Inthe timing section, set the timing to one hour, and set the notification frequency to 'Only once
when the condition applies'. So this means that the condition will be checked every hour, but the

alert will be created only once.

Timing

How often ta check conditions | Hours |v| | 1

YWhen to start notifications | | GMT-05:00 |n| [ Americamiew_vork v |
Motification freguency | Only onee when the condition applies | V|

___h. Click the Alert Content tab, and view the default message that is created.

___i. Update the body to include the KPI value.

1) Select 'Define your own content'

2) Add a blank line and put text 'Value is ' on the third line.

Bady

In=ert Dynamic YWalue

H/Declined_Order_KkPImame% In range %/Declined_Order_kPlirange/High_Range/name%

valueis|]

3) Click 'Insert dynamic value' in the body section

4) Navigate to Declined Order KPI > value

+| Co&verage Order Fulfillment KPI August 2008
| EaAverage Order Price KP1{Dollars)
=] ErDeclined Order KPI
Srvalue
dptarget
@name
+| B2 prediction
+| COranges
+| E20rder Count KFI
+| COPercent of Orders Approved kP

-

5) Click OK and you will see the dynamic value added to the body on the third line.

Conditions | Alert Content | Matification

() Generated content (@ Define your own content

Subject

Insert Dynamic Yalue

Declined orders high

Body

Insert Dynamic Yalue

Walue is ®iDeclined_Order_KPIvalue%

%iDeclined_Order_KPIname% In range %iDeclined_oOrder_KPlrange/High_Rangeinarme %
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6) Click OK

___]- Click the Notification tab, and you see that the user ‘admin’ is notified using a dashboard alert.

Conditions  Alert Cantent | Notification

Recipients ¥| Dashhoard Alert Cell Phone E-mail Pager
admin v
__ k. Click OK.

___|. Click OK. You should see the new alert in the list.

Alert Manager

Alertsto Display | All alerts [~ Mew Alert Save
Alert Name Description Owner Dashboard Alert Cell Phone E-mail Pager Actions
Declined orders high admin v —/ E—D % IL‘

3. Subscribe to an alert

___a. Inthe alert manager widget, you can select the check box next to the alerts you want to
subscribe to and click Save. When new alerts are sent, you will be notified via the mechanism
that you choose, either dashboard alert, cell phone, e-mail or pager. Phone, pager, and e-mail
information is configured by the administrator using the administrative console pages for action
services configuration in conjunction with user registry information. The pager and telephone fields
typically reference an e-mail address for a phone and pager service that handles the routing of the
messages.
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What you did in this exercise

In the lab, you imported the ClipsAndTacks model to a new workspace and published it to the Monitor Test
Environment

You used the supplied program to simulate the submission of events from the monitored application.

You created a new dashboard and added widgets to the dashboard and configured them.
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